


STANDARD

GOVERNMENT OF KERALA
GENERAL EDUCATION DEPARTMENT

STATE COUNCIL OF EDUCATIONAL RESEARCH AND TRAINING (SCERT), KERALAM
2025

INFORMATION & COMMUNICATIONS TECHNOLOGY

X
Part II



INFORMATION & COMMUNICATIONS TECHNOLOGY - X
Prepared by :
	 Kerala Infrastructure and Technology for Education [KITE]
	 Poojappura, Thiruvananthapuram - 695012, Kerala
	 For State Council of Educational Research and Training (SCERT)
	 Poojappura, Thiruvananthapuram - 695012, Kerala
	 First Edition	 : 2025
	 Website		  : www.kite.kerala.gov.in,  www.scertkerala.gov.in
 	 email		  : contact@kite.kerala.gov.in, scertkerala@gmail.com
	 Phone		  : 0471-2529800, 0471-2341883, Fax: 0471-2529810, 0471-2341869
	 Type setting	 : KITE
	 Layout		  : KITE	
	 Printed at	 : KBPS, Kakkanad, Kochi - 30
	 © Department of Education, Government of Kerala

NATIONAL ANTHEM

PLEDGE

Jana-gana-mana adhinayaka jaya he
Bharatha-bhagya-vidhata,
Punjab-Sindh-Gujarat-Maratha
Dravida-Utkala-Banga
Vindhya-Himachala-Yamuna-Ganga
Uchchala-Jaladhi-taranga
Tava subha name jage,
Tava subha asisa mage,
Gahe tava jaya gatha.
Jana-gana-mangala-dayaka jaya he
Bharatha-bhagya-vidhata,
Jaya he, jaya he, jaya he,
Jaya jaya jaya jaya he!

India is my country. All Indians are my brothers and sisters. 

I love my country, and I am proud of its rich and varied heritage.  
I shall always strive to be worthy of it.

I shall give my parents, teachers and all elders respect, and treat everyone 
with courtesy. 

To my country and my people, I pledge my devotion. In their well-being 
and prosperity alone lies my happiness



Dear students,

The advancements in Information and communications technology have im-
pacted every walk of life. The new age gives us the message that we need to 
stay updated throughout our lives. This book has been prepared to  
cover the latest domains in information communications technology, helping 
us stay in tune with these developments.

The chapters in this book, such as Graphic Designing, Desktop  
Publishing, Webpage Designing, Python Programming, Robotics, Animation, 
Database Management, and Cyber Space, are designed to help you think  
creatively, experience new concepts, and present novel ideas.

This book includes interesting activities involving Stellarium, the  
desktop planetarium software; GeoGebra, the interactive geometry software; 
and similar tools. These tools would help you apply your learning to other sub-
jects easily.

It is expected that the ICT tools you are familiar with will enable you to acquire 
knowledge through innovative methods. It will help you become a  
creative individual who can use technology in your own life and for the  
advancement of society.

				    With regards,

Dr. Jayaprakash R.K
Director
SCERT. 
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Learning science through computers

Many software applications are available today to make learning of science interesting and 
fun. Our operating system contains free educational software that helps in the study of sky 
watching, map study, elements and molecules. Virtual labs, simulation software, and interactive 
software can be used to observe and test various concepts. Let's try some interesting activities 
using such software.

Chapter 7
Learning Science Through Computers 

"The 'white nights' of Finland were a fascinating 
experience for us Indians. Our hostel building  is 
on the banks of a lake in Otaniemi. When I look 
out the large window in my room on the fourth 
floor, can clearly see a part of the lake. When we 
go to bed after dinner, we usually lower the thick 
curtains and invite in the darkness. Sometimes 
I wake up earlier than usual. I look at the clock 
and it's 3 am or 3.30. When I open the curtains, a 
bright light floods the room."

7.1 See the Midnight Sun
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Stellarium
Stellarium is a free desktop planetarium software that simulates 
various views of the sky.

We can see past and upcoming celestial phenomena in it. This 
is a very helpful software for stargazing and sky watching.

Given above is a part of S.K. Pottekad's travelogue ‘In the land 
of the Midnight Sun’.

Have you ever wondered about the midnight sun? There are 
places like this on our planet. If you travel to cities near the polar 
regions, you can experience months of darkness-free nights.'  
These nights, celebrated by the locals as the ‘White Night 
Festival’, are a phenomenon experienced only by those who 
live in areas beyond the Arctic and Antarctic circles. Living 
in a land close to the equator, the sun rising at midnight is 
unfamiliar to us. Is it possible to see the sun rising in the 
midnight sky without going to Finland, Russia, Norway, or 
Canada?"

In previous classes, we learned that we can observe the sky 
from any location on Earth using the Stellarium software.  

Let’s open Stellarium and observe a simulation of the sun 
rising in the midnight sky in regions beyond the Arctic and 
Antarctic circles.

To observe a celestial body in the Stellarium software, the 
following steps must be performed.

	� Place of observation should be set.

	� The observation time (date and time) should be set.

	� You must select the celestial body to be observed..

To set Place of Observation 
The view of the sun from the polar regions is different from the 
view of the sky from the equator.

Using Stellarium, you need to select a location north of the Arctic 
Circle to view the midnight sun. Using the Location Window 
feature in the Stellarium software, set the observation location 
to the city of Tromso, Norway.
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To Set the  Location in Stellarium Software

	� Click on the Location Window (F6) tool at the top of the toolbar.

	� Type the location you want to search for in the Search bar in the Location window.

	� Select the exact location from the search results.

	� You can also adjust the location by clicking on the map in the Location Window.  Click 
at the point to observe.

	� If the location is not accurate, just click Reset Location List and adjust the location again.

Fig. 7.1 Stellarium Main Window

Fig. 7.2 Stellarium- Location Window
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Haven't you selected the city of Tromso as an observation 
point? Make sure that the location details now visible in the 
window are the same as given below.

Details of the town of Troms

      	 Name/City		  :	 Tromso

         	 Country 		  : 	 Norway

	 Latitude		  :	 N 690 38’ 56.05”

	 Longitude		  :	 E 180 57’ 18.29”

Next, let's set the observation time.

To Adjust Day and Time 
In places north of the Arctic Circle, the midnight sun  is 
visible during summer. The Northern Hemisphere experiences 
summer in the months of June and July.

What if we chose the last day of the solar eclipse, the summer 
solstice (June 21), to observe the sun?

Arrange the observation day in the time setting window for 
21st June at six o'clock in the evening.

To Observe from the Moon

	� Click on the Location Window (F6) tool at the top of the toolbar.

	� In the window that opens, under the map, select Moon under Planet.

	� A list of locations included in the software will appear. You can select the desired location 
and set the  location.

Fig. 7.3 Stellarium - Landscape Tab
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To set the observation date, click on the window available when 
selecting the Date/Time Window (F5) tool on the toolbar. Just 
arrange the required time.

To get the impression of observing from the lunar surface in the Stellarium,

	� Click on the Sky and Viewing Options window [F4] in the toolbar.

	� Select the Landscape tab in the window that opens and select Moon from the list on the 
left.

Fig. 7.4 Date  and Time window in Stellarium

Tromso
Tromso is a city in northern Norway, located 300 kilometers north of 
the Arctic Circle. This city, often called the gateway to the Arctic, was 
where early  Arctic exploration began.

From May 18 to July 26, the midnight sun rises in Tromso. Between 
March 27 and September 17, there is no night in Tromso unlike in India. 
From November 26 to January 15, Tromso experiences polar night. 
During this time, the sun goes below the horizon.

Let's Observe the Sun
Now, let's look at a simulation of the sun at night from the city 
of Tromsø, Norway.

There are millions of objects in the sky. Now we need to show 
exactly which object we are observing. To make the midnight 
sun visible, search for the sun in  the Stellarium search window.
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Fig. 7.5 Search W indow in Stellarium

‌Now close the search window. Isn’t the sun visible in the sky 
in the software window?

To Search for Celestial Bodies in Stellarium

	� Click on the Search Window (F3) tool in the toolbar.

	� Type the name of the object you want to search for in the search bar and press Enter (to 
search for the Sun, just type Sun).

White nights
White nights are a phenomenon experienced during the summer in areas north of the Arctic 
Circle and south of the Antarctic Circle. In the Northern Hemisphere, the white nights occur 
during the weeks leading up to the summer solstice in June. During this time, sunrises are 
earlier and sunsets are later. In the polar regions, the sun is visible all day long. In the Southern 
Hemisphere, this occurs in December.

Many cities north of the Arctic Circle in countries such as Russia, Norway, and Finland 



Information and Communications Teahnology - 10 13

Learning science through computers

Record the direction in which the sun is visible  in Table 7.2. 
Use Table 7.1  to understand the direction.

Direction Indicators Directions

N North

NE North East

E East

SE South East

S South

SW South West

W West

NW North West

Table 7.1 Direction Indicators in Stellarium

If you don't see the direction on the screen, just zoom in and 
zoom out by moving the mouse scroll wheel.

Then, open the Date and Time window, click on the minute 
and continuously change the time to observe the sun's path.

hold all-night celebrations during this time. These celebrations are known as White Night 
Festivals. The White Night Festival held in St. Petersburg, Russia, is famous.
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Date Time Position of sun 

(Direction)

June 21

0 : 30 : 0 North
4 : 0 : 0

7 : 0 : 0

10 : 0 : 0 South-East
12 : 30 : 0

15 : 0 : 0

18 : 0 :0

21 : 30 :0

June 22

0 : 30 : 0

3 : 0 : 0

6 : 0 : 0 East

9 : 0 : 0

12 : 30 : 0

15 : 0 : 0

18 : 0 : 0

21 : 30 : 0 North West

Table 7.2 Position of the Sun at Different Times

Observe the sunrises and sunsets these days. What features do 
you see?

You can increase the speed of time by clicking on Increase 
Time Speed (L) in the status bar.

Click on it three times to see the movement of the sun as an 
animation.

You can see that the sun is visible in the sky all day long 
without going below the horizon. When you run the animation, 
make sure that the sun is in the selection, ok?

To set the time rate to normal speed, simply click on Set normal 
time rate (K).

Solstice
At the end of the Northern 
Solstice, the Sun is directly 
overhead at the Tropic of 
Cancer on June 21, known 
as the Summer Solstice. 
This day has the longest 
day and shortest night. At 
the end of the Southern 
Solstice (December 22), 
the Sun is overhead at the 
Tropic of Capricorn, marking 
the Winter Solstice, when 
the Northern Hemisphere 
experiences the longest night 
and shortest day.
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Direction of the Sun During the Summer Solstice
Have you observed the movement of the sun during 
summer solstice in places north of the Arctic Circle?
Now, observe the journey of the Sun from sunrise to 
sunset from places located at different latitudes in the 
Northern and Southern Hemispheres on these days. Then, 
find the difference in the journey of the Sun and complete 
the table given below (Table 7.3).

Place Country Latitudinal 
Position

Direction of movement of 
Sun

Kuala Lumpur Malaysia 30 8’ 28.32” N

Kolkata India
220 33’ 45.47” N

The Sun rose between the north 
east and the east.

  moved overhead, towards 
slightly north, 

and set between the north west 
and the west.

Anchorage
United States of 

America
610 13’ 5.01” N

Talnakh Russian Federation 690 29’ 11.41” N

Alice Springs Australia 230 41’ 50.93” S

Sydney Australia 330 52’ 4.26” S

South Pole 
Telescope

Antarctica 900 0’ 0.00” S

Table 7.3 Sunrise and Sunset Times at Different Latitudes
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Let's evaluate
 	 Which of the following planets makes it impossible to observe celestial bodies in the 

Stellarium software?

	 a)	 Mercury		  b)  Venus		  c)	 Uranus	d)  Neptune
	 Which of the following locations in the Stellarium software can be used as an observation 

point to view the midnight sun?
	 a) Alice Springs 	 b) Kuala Lumpur	 c) Sydney 		  d) Talnakh

Extended activities

1.	 Observe the Earth from the Moon and find the difference between day and night in the 
northern and southern hemispheres during different months and record it in a table.

2.	 Observe the solar eclipse that occurred in Dallas, the United States, on April 8, 2024 at 1:40 
PM in Stellarium. Then find the start and end times and record them in your notebook.

You have seen the poster of the International  
Day for Disaster Risk Reduction celebration 
organized in the school under the leadership of the 
District Disaster Management Authority (Figure 
7.6). October 13 is observed as the International  
Day of Disaster Risk Reduction every year 
to reduce the risk of disasters worldwide by 
raising public awareness about the risks and the 
precautions we need to take to  face  disasters.

7.2 Resource map

Natural disasters are a big challenge for any society. 
Kerala has witnessed various types of natural disasters 
in the recent past. Let's take a look at the major natural 
disasters that Kerala has witnessed in the last few years.
	� Flood

	� Landslide

	� Soilslide		

	� ............................................................

Governments are devising and implementing various 
measures prevent natural disasters.  Adopting measures to 
prevent disasters, taking actions to  address inevitable ones, 

District Disaster Management  Authority &  
Govt Higher Secondary School Irumbiliyam

Fig.  7.6 Poster showing International 
Disaster Risk Reduction
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Disaster Risk Area Maps
A disaster risk area map is a map that highlights the vulnerabilities and potential hazards of a 
specific area. It indicates where damage is likely to occur during a disaster and suggests what 
precautionary measures can be taken. The importance of such a map is outlined below:

	� Precautions: Helps in identifying areas prone to disasters and taking necessary safe guard 
in advance.

	� Planning: Aids in planning disaster prevention activities and in the efficient allocation of 
resources.

	� Response: Assists in determining where to begin rescue and relief operations during a 
disaster.

	� Awareness: Helps educate the public about potential disaster risks and enables them to 
learn self-protection measures.

A disaster risk area map is an important tool for understanding the vulnerability of an area, 
identifying risks, and strengthening the process  of  disaster mitigation.

conducting  post-disaster rescue operations and raising public 
awareness are all part of disaster management.

Discuss with your friends what things your school can do as 
part of disaster management activities and write them down in 
your notebook.

	� Participate in disaster relief operations.
	� Implement nature conservation activities.
	� Organize awareness activities.
	� ...............................................................................................
	� ...............................................................................................

Disaster risk area maps can play a major role in planning 
precautionary measures related to natural disasters and effectively 
dealing with natural disasters.

Geographic Information System software can be used to 
prepare disaster risk maps. The Kite GNU Linux we use 
includes a geographic information system software called 
Quantum GIS. Using this, we can perform various types of 
analysis and prepare resource maps that can anticipate disaster 
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Geographic Information System Software 
Geographic Information System software is a software system for recording the features and 
spatial information of the Earth's surface in multiple layers. Geographic Information System 
software can store and analyse information. Quantum GIS, GRASS, and Arc GIS are the 
leading geographic information system software. Of these, Quantum GIS and GRASS are 
free software.

Fig. 7.7 Quantum G.I.S Window

Haven't you heard about how climate change at the global level 
is causing natural disasters in places including Kerala?

School G.I.S

School GIS (https://schoolgis.nic.in/) is an  online 
geographic information system  portal designed 
to make information  about schools across the 
country available to the public.

situations, which helps in taking precautionary measures, 
planning and developing an action plan.

Landslides are a natural disasters that Kerala 
faces. Details of major landslides that have 
occurred in Kerala have been recorded in a 
data set named kerala_landslide_catalogue_
point.csv in the School_Resources/Class_10 
in QGIS folder.

Let's see how to include this file into a QGIS 
map and examine the information recorded in 
it. To do this, follow  the steps given below.
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To check the resource map in QGIS software

	� Open QGIS and  click  Project → Open to open the map QGIS/Kerala provided in the 
QGIS/Kerala folder.

We can add data on major landslides in Kerala in a new layer to this map. For this,

	� Click on Layer → Add Layer → Add Delimited Text Layer  in the menu bar.

	� In the opened Data Source Manager | Delimited Text window, click Browse in the File 
name section and select the data-containing file named kerala_landslide_catalogue_point.
csv.

Fig. 7.8 Qgis – Source Manager Window

	� Make the following settings in the window.

	� File Format : CSV (Comma Separated Value)

	� Geometry Definition : Point coordinates

	� X Field – Longitude, Y Field – Latitude
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	� Geometry CRS : EPSG:4326 – WGS 84

	� Then click Add.

	� Now, close the Data Source Manager | Delimited Text window.

With this, you will see that the data we have included in a new layer (Layer Type - Point) is 
depicted on the map. To view information about any point recorded on the map,

	� Select the new layer.

	� Then click on the Identify Features tool and click on the point where you want to get the 
data.

	� The data of the (landslide) recorded there will be displayed in the window that opens.

Fig. 7.9 Data From the CSV File Displayed on a QGIS Map

Use the Identify Features tool to click on points 
in each district on the map and examine the 
details recorded on it.

In this way, find information about landslides 
in various districts of Kerala  from the map 
and complete Table 7.4.

To see a list of all the information 
 recorded in a layer,  right click on the layer 
and simply open the Open Attribute Table.
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District
Places where 

landslides 
occurred

Date Time Reason Latitude Longitude

Kannur
(1)

(2)

Wayand
(1) Puthumala 8/8/2019 5:03:44 Continuous 

rain
11.50340214N 76.13474585E

(2)

Kozhikode
(1)

(2)

Malappuram
(1)

(2)

Idukki
(1)

(2)

Table 7.4  Details of Landslides

Let's Check the Possibility of Landslides.
The table shows the common causes of landslides (Table 7.4).

QGIS software can also be used to prepare maps of landslide-
prone areas. See what information is needed for this.

	� The slope of an area

	� Rock structure

	� Land use

	� Amount of rain

	� ..............................................................................................

	� ..............................................................................................

Digital Elevation Model 
(DEM) 

A digital elevation model is a 
3D graphical representation 
of data representing the 
elevation of a planet, a region 
of the earth, or objects on 
its surface. DEMs are used 
in geographic information 
systems.
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Shall  we create a map in QGIS that would help us understand 
the slope of places in Wayanad district?

For that, we need the DEM (Digital Elevated Model) data of 
the district .

A file containing DEM data for Wayanad district is stored in the 
QGIS folder on the computer as an image file named DEM_
Wayanad.tif. Let's see how to perform the above operation 
using this file.

To Find Out the Slope Details of an Area

	� Open the QGIS software and start a new project via Project →New.

	� DEM data is available as a raster image file. To add it to a map,

	� Click Layer→  Add Layer → Add Raster Layer.

	� In the  Data Source Manager | Raster window that opens, make sure  Source Type → 
File.

	� Then, browse to the Source 
Raster Dataset section and 
select the required Raster Layer 
/ DEM (Eg: DEM_Wayanad.
tif) and add it.

	� Then select the new Raster 
Layer and click Processing 
Toolbox in the Menu bar. 	

This will display the 
Processing Toolbox on the 
right side of the window.

	� OpenGDAL → Raster 
analysis → Slope in the 
toolbox and double-click 
on Slope

Fig. 7.10 DEM The Way to Add a File in the Map - Step - 1

Fig. 7.11 How to Add a DEM File to a Map – Step 2
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	� In the Slope window  that opens, 
make sure that the raster layer 
(DEM Wayanad) is active   in the 
Input layer

	� Make sure the ratio of vertical unit 
to horizontal value is 1.

	� In the Slope section, select the 
location where you want to save the 
newly created Slope layer, give it an 
appropriate name (Slope) and save 
it.

	� Then click Run to complete the layer 
creation process. You can then close 
this window.

Fig. 7.12  Settings When Adding a DEM File to a Map

Fig. 7.13 Slope Analysis Map of Wayanad

Didn't you get a new map when you completed the above task?

What is the peculiarity of  the map that is now available?  

	The slope of the area cannot be understood from this map.

	 Since it is a single-colour (single-band) map, it is also 
difficult to understand the slope information.
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To solve this, we can give different colours to the map according 
to the slope of the area. That is,

	Areas with a certain degree of slope can be given the same 
colour.

	Different colours can be assigned to represent different 
slopes.

To do this, try the steps  given below.

To Give Different Colours to the Slopes

	� Right click on the newly created Slope layer and open Properties.

	� Then make the necessary changes to the Symbology in this window.

 Render type : Singleband pseudocolor  

 Interpolation : Linear  

Fig. 7.14 Settings to Give Different Colours to the Slope 
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	� Color ramp: Spectral - Invert color ramp (27.14)

	� Mode : Equal Interval

	� Classes: Appropriate number.

	� Label Value: Places with a certain degree of slope can be considered as each category and each 
category can be given a different colour. (Example: 0, 5,10, 15, 20, 30, 40, 50, 60, 70, 80). The 
colours of other categories should be different from the colour given to one category.

	� You can change the label value by double-clicking on Value.

	� To change the colour - Double-click on the colour box next to Label Value and select the appropriate 
colour from the window that opens.

	� After making changes, click Apply and then click OK. 

Fig. 7.15 When Different Colours are Given to the Slopes

Now the slope of the map is available in different colours. 
Now, you can print this analysis map and use it. Don't forget to 
save the project in your folder.

Printing the Map
To print the map we have prepared, we can use the New Print 
Layout feature in Quantum GIS.

Print the map you have prepared as an image file as shown 
below.
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To Print the Map
	� In QGIS, select New Print Layout 

from the Project menu.

	� In the next window, give the map a 
title and continue.

	� Then, in the window that opens, 
click the Add Map button and drag 
the map diagonally on the canvas 
using the mouse.

	� You can add the necessary 
information to the map using tools Fig. 7.16 New Print Layout Window

like Add New Label and Add New Legend.

	� Then, export the map using the Export As option in the Layout menu.

Fig. 7.17 When Map is Added in New Print Layout

Let’s Assess

 	Which of the following is an online geographic information system portal?

	 a) Quantum GIS.       b) Grass GIS              c) School GIS           d) Map Info Pro
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Extended  Activities

1.	 Open the Slope map we prepared and the Places_Kerala.gpkg file provided in the QGIS/
Other_Files folder in QGIS. Find and list the places in the steepest areas on the map.

	 Which of the following is not an open source geographic information system software?
	 a)Quantum GIS. .  			  b) Grass GIS
	 c) Arc GIS  			   d) Map Info Pro 

We know that the location of any place on this globe can be 
represented by latitude and longitude coordinates. Similarly, 
any point on a plane can be represented by a pair of numbers 
(index numbers). We have learned from math classes that the 
location of a point on a two-dimensional plane is determined 
based on the x-axis and the y-axis.

Look at Figure 7.18. What will be the index number of  the 
point marked in this?

There are also index 
numbers at locations.

7.3 Geometry of Equations
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Fig. 7.18 Point Marked in a Plane

You have  been introduced to GeoGebra software in previous 
classes, which helps you create geometric structures on a 
computer. Have you noticed that the index numbers of the points 
marked on the plane appear in the Algebraic View in GeoGebra?

Fig. 7.19  GeoGebra Window 

Indicative Numbers in GeoGebra
Open the GeoGebra software and draw points A and B on the 
plane as shown in Figure 7.20. Then construct a straight line 
passing through these points.

Geo + Gebra = GeoGebra

The words Geometry and 
(Algebra)  are coined to get  
the term Geogebra
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Remember that the positions of the points on the plane must be 
A=(3,2) and B=(1,4) respectively.

What tools did you use for this?

	� ...............................................................................................

	� ...............................................................................................

Now, check how the points and lines you just marked are 
indicated in Algebra View.

Fig. 7.20 Algebraic View in Geogebra

Now, two more points C and D are marked on this line. What 
change was observed in the Algebraic window?

Now, find the index numbers of the points you just created 
from the Algebra View window and write them below.

	� ...............................................................................................

	� ...............................................................................................

We have created structures using GeoGebra tools. Can structure 
be created in GeoGebra by entering index numbers?

Let’s Draw without Tools

Type A(1,2) in the Input Bar at the bottom of the GeoGebra 
Algebraic View and press Enter. (Figure 7.21)

Point A appeared and  on the screen without using the Point 
tool, did'nt it?.

Algebraic View

If the Algebra view is not 
visible when you open 
GeoGebra, check Algebra 
from the View menu. You 
can also display Algebraic  
View using the shortcut 
Ctrl + Shift + A.
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Now, type B(1,3), C(1,4), D(1,5) one by one in the Input 
Bar and press Enter.

Fig. 7.21 Input Bar in GeoGebra

What is special about the points A, B, C, and D that are now 
visible on the screen?

	� ...............................................................................................

Using a short line, we can connect all four of these points. 
Which tool should we use in GeoGebra to do this?

	� Segment tool

Let's see how to draw this small line using the input method 
instead of using the segment tool.

Look at how the points marked so far are indicated in the 
Algebra view.

• A=(1,2)

• B=(1,3)

• C=(1,4)

• D=(1,5)

Input History

Place the cursor ,  in 
the input bar, then press the Up 
Arrow and Down Arrow keys, 
to see the previously entered 
inputs.
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In other words, we have now marked points A to D in GeoGebra.

Now, type Segment(A,D) in the input bar (Figure 7.22).

Fig. 7.22 Line Segment Drawn Using the Input Facility in GeoGebra

We now have a short line parallel to the y-axis. As you have 
learned from your math textbook, if you extend this short line 
to both sides, the equation of that line is x=1.

Then, try typing x=1 in the input bar (Fig 7.23)

Then, the equation of the line parallel to the y-axis is x=1.

Fig. 7.23 Equation of the Line Segment in Input Bar

Some equations are given in Table 7.4. Complete the table 
by entering these equations in the Input bar in GeoGebra and 
observe the results obtained.
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Equation Features of the Constructions
y=2

x=y

x-y=5 No matter which point on the line is taken, the difference between 
its indices will be 5

y=2x

2x+y=5

Table 7.4 Equations and Features of the Constructions

More Constructions
So far, we have only created points, segments, and lines using 
the Input system. What if we created some other geometric 
shapes using Input?

Try typing the equation y = x2 in the Input bar..

What is the name of the shape you just got?

	� ..............................................................................................

Quadratic Equations in the Input Bar
When typing quadratic equations in the input bar in 
GeoGebra, you must use the ^ symbol on the keyboard.
   Example :  y=x^2

Now, enter the equation x2+y2=2 in the input bar and try 
constructing circles with different radii.

Let’s Evaluate

 	 Which of the following would be an equation for drawing a line parallel to the Y axis using 
the input tool in GeoGebra?

	 a)	 x = 2					     b)  y = 2       
	 c)	 x=2y       				    d)  y=2x
	 Which of the following constructions will be obtained if you type A(1,5) in the Input bar of 

GeoGebra software?
	 a) Pint 					     b) Line 	
	 c) Circle 					     d) Short line
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Extended Activities

1.	 Draw a circle with centre A(1,4) and radius 2 units using the Input method in GeoGebra 
software.

2.	 Draw  line segments  y=2 and y=2x in GeoGebra software and find their intersection point 
using the Input method.


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Chapter 8
Let’s Give Life to Pictures 

Have you noticed the picture of a plant and a puppy in the lower 
right corner of the right page of our ICT textbook ?

Turn the page.  You can see the same picture at the same place 
on the next page too.

And what about on the next page ?

Turn the pages one by one. Are the pictures same on every page?

Now, quickly turn the pages from the first page to the last page. 
What do you see?

It looks like as if the plant is growing and the puppy is looking 
at the plant wagging its tail, right ?

Have you ever wondered how this is possible ?

Notice that each page has different pictures of the puppy and 
the plant. These include different stages of the plant growing 
and the puppy wagging its tail.
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Persistence of Vision
An image that falls on our eyes remains on 
the retina for a short time (one sixteenth of a 
second).  This feature is called Persistence of 
vision.  When another image falls on the retina 
during this time, we experience the second 
image as a continuation of the first image.

When the continuous and sequential images of 
the movement of the puppy and the plant were 
rapidly captured one after the other by our eyes, 
they were perceived as a motion.

It is because of the unique feature of our eyes 
called ‘persistence of vision’ that the still images 
in the textbook seemed to come to life.  It is by 
making use of this feature that the technology 
of animation came into existence.

Let’s Make an Animation Video
Animation is a field that quality interests all of us.  Earlier 
we were familiar with animation through cartoon movies on 
television channels, but today we constantly see and make use 
of it in educational videos, advertisements, reels, and greeting 
messages.

In the past, animation films were made using painted plastic 
sheets.  With the advent of computer technology, the animation 
technology has become more popular and the production has 
become relatively easier.

Phenakistiscope is the first device used to simulate animation.  Sequential images of the various 
stages of an object’s movement is drawn on the surface of a circular hardboard.  When it is rapidly 
rotated using a stand, the object on the hardboard appears to move.  Based on this technique, 
animations were created in the beginning of 19th century.  The possibilities of animation were 
introduced with the help of devices like phenakistiscope during 1830s.

Phenakistiscope Phenakistiscope

Let’s Make an Animation Video
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Didn’t you notice a small animation hidden within the ICT 
textbook ?  This is a Flipbook animation.  Instead of that, shall 
we try to create a real animated movie ourselves ?

To create an animation, some preparations are necessary.  Just 
like in the making of a film, play, or a documentary, an animated 
movie is also created through various stages.

You have learned in previous classes that for 
preparing a film or documentary, it requires a 
story, a script, characters, and dialogues.

Find out what all preparations are needed to 
prepare an animated film and complete the list 
given below.

	� A theme is required

	� Story based on that theme should be prepared

	� The order in which the events in the story are 
presented, or the scenes should be determined.

	� A story board including the details of each 
scene should be prepared

	� .....................................................................

	� .....................................................................

	� .....................................................................

We have understood what all preparations are 
necessary to make an animation film. Based on 
this, let us now learn how an animation film is 
made.

An animation film should be made based on a 
particular theme or concept.

Now closely observe the flipbook animation 
included in the textbook. What is the theme of this 
animation? Discuss with your friends and find out.

Let’s prepare an 
animation to present on  

Environment Day

Flipbook
A flip book is a type of illustrated book.  It is 
also known as Flickr book and Kineograph.  
They are made by adding a series of images 
that change very gradually from one page to the 
next. When we look at these pages continuously, 
we feel that the images are moving.

There are websites and software packages 
available on the Internet today that can convert 
PDF pages and digital videos into desired 
Flipbooks. Search them in the Internet and 
try out.
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Shall we consider this animation as a specific scene from an 
animated film that promotes environmental protection?

If so, think about what other situations there might be.

The plot of an animated film based on this theme, namely 'Luna', 
as prepared by some friends, is given below.

Luna (Animation Film) – the Storyline
A plant that has withered from not having enough water.  A small puddle in the distance.

Small clouds in the sky.

A puppy (Luna) comes near the puddle.

The puppy makes a channel in the soil with its front paws and

brings the water to the plant.

You have seen the staryline of the animated film.

Which characters should be included when this story of Luna 
is made into an animated film?

	� Luna

	� ...............................................................................................

	� ...............................................................................................

	� ...............................................................................................

	� 		  Character Design
Character design is a very important step in 
animation production. It is the process of creating 
the characters in a way that suits the needs of the 
story.  While designing characters, it would be good 
to take the following aspects into consideration 
as well.

	� Variation in the shape of the characters

	� Appropriate selection of colours

	�  Drawings that can be easily modified

You have seen that a large number of images 
are required to create an animation. The story 
should be divided into different scenes based 
on the background and context in which they 
take place. The images should be designed 
with detailed illustration of the characters in 
each such scene.

Designing characters is a task that requires 
utmost care. It requires skill and expertise 
in drawing.
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With the advent of software-based animation production, 
creating drawings for animation has become much easier. 
Animation software usually includes built-in tools for drawing. 
It is also possible to create drawings using dedicated drawing 
software and then importing them into animation software to 
create the animation.

Different Types of Animation
Animations are created in 2D and 3D formats. 2D animation is a method of creating animation 
based on 2D images. Walt Disney's The Jungle Book, Bambi, Cinderella, etc. are famous 2D 
animated films. Open Toonz, Tupi Tube Desk, Synfig Studio, Adobe Animate, etc. are software 
that helps in creating 2D animations.
3D animations are created by preparing 3D shapes of the characters and backgrounds. Movies 
like Big Buck Bunny, Shrek, and Wall-E were created in this way. 3D animation is also widely 
used in games today. Blender, Autodesk Maya, and Adobe Dimension are examples of 3D 
animation software.

When Luna’s story is divided into individual scenes, which are 
the characters to be included in the first scene? Discuss.
The next step in creating the animation is to convert the prepared 
story into a storyboard.  A storyboard is detailed preparation of 
each scene in advance..
Based on the first scene of Luna’s story, a sample 
storyboard has been provided below (Table 8.1). 
Discuss with your friends and prepare the storyboards for the 
other scenes using this sample as a model.

Titile : Luna                                                                   Page Number : 1

Scenes Background/ 
Characters Action Dialogue Music Time Remarks

Scne 1 Withered plant, 
small puddle, 

sky

Clouds are 
moving in the 

sky

Background 
music

5 second

Scne 2

Scne 3

Table 8.1 Model of a Storyboard
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You've seen the storyboard for the first scene. Now let's create 
the animation based on this.

OpenToonz

OpenToonz is a free animation 
software based on “Toonz”  
software developed by Digital 
Video S.p.A. in Italy. It provides 
tools for drawing, animation, and 
sound. 

The Japanese animation film ‘Belle’ released in 
2021 was created using OpenToonz software.

Towards Motion
We shall first prepare the scene that includes 
the movement of the clouds as described in 
the first scene. Let's create this animation 
using the OpenToonz animation software 
available on the school computer. 

In our scene, we need a withered plant and 
a small puddle in the background. This 
animation will be possible only if we have 
images of all these. 

We have already learned in previous classes 
how to create images using Krita, GIMP, 
and Inkscape. We can prepare the images 
using those software tools, or we can draw 
them directly in OpenToonz to create this 
animation.

Open OpenToonz on your computer and create a project for 
the first scene. 

To Create a Project in OpenToonz

	�  Open OpenToonz software

	� In the OpenToonz Startup window that opens,  click New 
Project to create a new animation project.

	�  Enter a name for the project (here Luna) and click OK 
(figure 8.1)

	� Click Create a New Scene in the OpenToonz Startup window

	� Then, enter the name of the scene and video settings in the 
window that appears. (Figure 8.2)

Fig. 8.1 New Project Window

The animation we create will be available to us in the form of 
a video file. When creating an animation video, the quality and 
frame rate of the video files need to be set in advance in the 
video profile.
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The necessary settings for this also 
need to be entered in the OpenToonz 
Startup window. 

A model of the settings that can 
be entered for video profiles in 
OpenToonz is given below.

Fig. 8.2 OpenTooz Startup Window

Scene  Name : Scene1
Camera Size : HD720,1280x720, 16/9

Units : pixel
Frame Rate : 12

Similarly, you may configure 
necessary settings for your 
animation project.

Once you provide the necessary settings for the first scene 
and click on Create Scene, the window required to create the 
animation will appear.

Did you get the OpenToonz window ? (See Figure 8.3)

Use the mouse scroll wheel to adjust the view so that the entire 
canvas is visible.

Fig. 8.3 OpenToonz Startup Window - Animation Room

Menubar Viewer

Toolbar

Xsheet
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Frame Rate

In animation, a frame can be considered as a still image. Animation is possible by displaying 
many such frames continuously. The number of frames displayed in one second is called 
Frame rate (Frame per second, FPS). This is a factor that determines the naturalness of the 
movement in the animation. We can set FPS according to the needs of each animation.

Let’s Set the Background
According to our storyboard, in the first scene, we need to create 
a withered plant, a puddle, and clouds moving across the sky.

	� 		       Xsheet

Xsheets are a feature available in OpenToonz for 
organizing the content of animation scenes. It is 
a concept similar to timelines in video editing 
software. Xsheets are arranged in different 
columns, with each column functioning as 
a separate track. Frames are arranged in the 
columns as cells.

As mentioned earlier, animations can be 
created in OpenToonz by drawing the 
necessary images directly or by including 
pre-made images in the scene. Although 
simple images can be drawn using the drawing 
options provided in OpenToonz, it is more 
convenient to prepare and use complex images 
with the help of other drawing software that 
we are familiar with.

Some of the images, image sequences, and audio files for 
preparing our animation are provided in the folder namely 
Class_10/Animation in School_Resources on the computer. These 
files may be used accordingly while creating the animation..

Arrange the Resources
In order to include the resources in OpenToonz, copy the 
Animation folder provided in School_Resources/Class_10 
and paste it into the Documents folder in Home.

To begin with we will create background for the first scene.  
Check the image namely bg.png provided in the Animation/
Scene_1 folder. Let's set this image as the background for our 
scene.

This should be done by opening the Animation Room in 
OpenToonz software.
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Rooms in the OpenToonz
OpenToonz has separate rooms for different activities. These are also known as workspaces. 
When you  open OpenToonz for the first time, the Drawing room opens.

Animation: This room is where you animate the position, rotation and size of the current 
objects.

Drawing: This room is used to draw, colour, and edit the drawings.

Open other rooms to find out what they are used for.

Fig. 8.4 Various Rooms in OpenToonz

To Include Image in OpenToonz
The background image should be included in the first frame of the first column.  

For this,

	� Select Animation room from the OpenToons window.

	�  Click on the first frame of the first column in the Xsheet.
	� Click on Browser Workspace in the menu bar.
	� Then browse to the folder where the images are stored from the 

window that appears.
	�  Select the image bg.png, Right-click and click Load.
	� Click Load in the dialogue box that appears.

The background image has now been set in the window. Now, 
let's return to the Animation workspace. 

Currently, the image we inserted appears only in the first 
frame.  For the animation to work properly, this image must be 
included in the other frames as well.  

We are creating a 5 second long animation with a frame rate of 
12 frames per second as our first scene.  So, think about how 
many frames are to be included in the first scene.

Fig. 8.5 When Imag 
 Included in OpenToonz
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This image in the first frame has to be included 
in the remaining frames too (60 frames in total), 
right?

OpenToonz has a feature called Click and drag 
to repeat selected cells to copy the content in one 

How many Frames?

For an animation of 1 second in 12 FPS 
: 1 x 12 = 12 Frames

For an animation of 5 second in 12 FPS 
: ................................

frame to other frames. Try using this to include the background 
image in other frames.

Once the work is completed, don't forget to click  File → Save 
All to save your work.

	� 		  To Include Images in  Other Frames

	�  Click on the first frame in Col1.

	� Click on the small button below this spell - Click and drag to repeat selected cells.

	� Drag the button to include the image up to the required frame.

	� This can also be done using the Repeat option too.

Repeat Button

The Repeat button can also be 
used to include the contents of a 
cell in other frames. To do this, 
select the image and click the 
Repeat button. In the window 
that appears, enter the number of 
frames and just click the Repeat 
button.

Now the background image has been added to all the

 frames of the first scene.

According to our storyboard, clouds are moving in the 
sky in the first scene.

Let’s see how can this be done.

Draw a Cloud
The background is prepared using an image drawn in 
another software. What about drawing the cloud in 
OpenToonz itself ?

Simple images can be drawn with the help of the drawing 
tools of the OpenToonz software.

The background is in the first column.  It is possible to 
give separate animations to the objects, if they are drawn 
in separate columns.

So, let's draw the cloud in the second column.

    Fig. 8.6 Repeat option in OpenToonz

Repeat Button
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OpenToonz allows you to create images as raster files or vector 
files. Here we are drawing the cloud as a vector image. 

To draw vector images, you need to set up the Vector Level 
window. Create a new vector level in the second column using 
the following steps.

To Create Vector level
	� Select the Animation Room.
	� Click on the first frame in the column (here - Col2) you 

want to include from the Xsheet.
	� Then, right-click here and select New Level.
	�  In the New Level window that appears, enter a name in 

the   Name field (Cloud).
	� Click the drop-down menu in the Type field and select 

Toonz Vector Level.
	� Click OK.
	� With this, you will see that a vector level named Cloud 

has been created in the selected frame.

Fig. 8.7 OpenToonz New Level Window

A vector layer is created to draw the cloud. Now, draw the cloud 
using the drawing tool.

We are now in the Animation room.  Find out the room for 
drawing the images. 

We have understood the 
peculiarities of Vector images 

in the first chapter.
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To draw images in OpenToonz

	� Select Drawing Room.

	�  Select Brush tool from the Toolbox to draw images.

	� Then draw the cloud.

	� Select the required colour from the Style Editor (Figure 8.9).

	� The drawn image can be erased using Eraser Tool.

	� Click inside the shape using Fill Tool to add colour.

	� To get a new colour, click New Style and select the desired colour.

	� Adjust the drawn image to the required size using the Selection Tool.

Fig. 8.8 OpenToonz Drawing Rooml Window

Try varying the Size, Accuracy, Smooth etc., while selecting the 
Brush tool to draw the image. What difference does it make?

Have you finished drawing the cloud ?

Now, we need to include this image in all 60 frames of the scene.  
Try doing it the same way as in the previous activity.

Colour Palette

Style Editor
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We have already seen some of the tools in OpenToons. What are 
the other tools in the toolbox? Try them and complete Table 8.2.

Fig. 8.9 Style Editor Window in OpenToonz

Fig. 8.10  OpenToonz Toolbox

Tool Name Tool Use

To adjust the position, rotation, size of the objects

Selection Tool

To draw geometrical figures

Type Tool

Table 8.2  Some of the Tools in OpenToonz and their Uses

New Style
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Let's Add Motion to the Images
We need to create an animation in which a cloud moves 
from one side of the sky to the other. Let’s see how to create 
this animation.

The movement of the cloud from one side to the other should 
be completed in 60 frames. In order to make this possible, the 
position of the cloud must change frame by frame according 
to its path of motion. That means we need to draw 60 different 
images, that differ in the position of the cloud drawn on the 
canvas, from one side to the other.

Instead, if we determine the position of the cloud in the 
first frame where the movement begins and the position 
in the frame where the movement ends, what if there was 
a technique where the software itself prepares the position 
of the cloud in each frame between them? OpenToonz 
also has the ability to create animations using a technique 
called tweening, which is commonly available in animation 
software. Try creating an animation of a cloud moving from 
one side to the other using Tweening animation.

Key Frames
When using tweening to create 
animation, the software must be 
able to predict the position and 
size of the object in each frame. 
This is based on the objects in 
some key frames that the animator 
determines. Keyframes are frames 
that are determined as important 
positions in the direction of 
movement in the animation. In 
OpenToonz, tweening animation 
can be created based on the 
Position, Scale, Rotation, Shear, 
and Center of the objects.

To Prepare Animation in OpenToonz
	� Click on the first frame in the column (Col2) where the cloud is drawn.

	� Select Animate tool from the Toolbox to give animation.

The software should set the position of the clouds in the other frames based on the position 
of the cloud in the first and last frames (keyframes). This is done using a technique called 
Position Tweening.

Fig. 8.11 when keyframe is set

	� Select Position from the animation option.

	� In the first frame, adjust the position of the cloud on 
the canvas to where the movement begins.

	� Now, the first frame has been set as a keyframe.

	� Next, click on the sixtieth frame and adjust the position 
of the cloud on the canvas to where the movement 
ends.

	� With this, the sixtieth frame has also become a 
keyframe. Our object is now ready for animation.
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The cloud animation has been created with the help of position 
tweening.
Press the Play  button below the canvas.  Does the animation 
work?

The tasks your are 
doing may be saved 

accordingly

Now, draw another cloud in a new column and give movement. 
Make the size of the cloud slightly different from the one you 
drew earlier...

We made the animation possible here by setting keyframes. Can 
we identify the frames that have been converted into keyframes 
from the columns in the Xsheet ?

Check the frames and find them.

Save the work using File - Save All.  Files in OpenToonz are 
saved as project files with  .tnz extension.
Let’s Include Background Music 

In movies, there are different ways to communicate effectively 
with the audience. The most important of these is the use of 
sound and music.  Shall we include some of these elements too 
in our small animation movie.

A file named bg_music_1.mp3 is provided in the Animation/
Scene1 folder on your computer for background music in the 
first scene. Add this file to a new column (Col4) and check the 
animation of the first scene.

We need to use the same method to add sound as we did for the 
image in the first column. However, since the sound file included 
in the first scene will also appear in other frames according to 
its duration, we only need to repeat them if necessary.
Let's Make a Video

A small step of including background music in our first scene 
has been completed.

Now it is saved as a project file of the OpenToonz software on 
the computer. We can see the animation only if we open it in 
the software used to create it.

Fig. 8.12 Video Controls
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If we export (render) the prepared animation as a video file, we 
can run it on the computer and mobile phone without the help of 
the OpenToonz software.  We have been familiar with this method 
when we made projects in video-audio editing software also.
Use the Render option in OpenToonz to prepare our animation 
in mp4 video and save it in your folder.

To Render Video in OpenToonz
	� From the Menu Bar ലെ� Render → Fast Render to MP4.

	� The video will be saved as MP4 after rendering.

Animation Using Image Sequences
We have completed all the tasks of the first scene according 
to the storyboard. With this, we have become familiar with 
creating animation using images.

OpenToonz has the facility to create animation using image 
sequences instead of images also. For this, we need to 
prepare image sequences in advance. Preparing and using 
image sequences that contain the characters to enable subtle 
expressions and movements will make the animation work in 
OpenToonz easier. Even if the scenes are to be reused, their 
image sequences are more  convenient.

Have you completed the storyboards for the other scenes of the 
animation you are going to prepare?

Below is the second scene of the storyboard prepared by Daya 
and her friends based on Luna's story. Let's prepare it with the 
help of the image sequences..

Fig. 8.13 Render Window
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Scene
Background / 

Characters
Action Dialogue Music Time Remarks

Scene 2
Water, plant, 

Luna

Luna brings 
water from the 
puddle close to 

the plant

Background 
music

5 second

Table 8.3 Luna –Storyboard Model (Scene 2)

See the Storyboard.  We have to show Luna bringing water from 
the puddle to the plant.  What images are needed to prepare this ?

For this, background image including the plant, image of puddle 
and the image sequence of the motion of Luna are given in 
Animation/Scene_2 folder.

We shall prepare the second scene using the images 
from Scene_2 folder and image sequence from Scene_2/
Sequence folder.

The second scene can can prepared in the same way 
as we have completed the first scene.

If the OpenToonz have been closed, open it again and 
ensure that the current project is Luna in the Startup 
window (Fig 8.14)

	� Click on the New Scene icon to begin the new scene.  

	� Give the name as Scene2

	� Give the Camera Size, Units, Frame Rate same as the first 
scene.

While Including Image Sequence
When image sequences are added, we can see that the images 
have been inserted into as many frames as there are images in 
the sequence. These images can be inserted into other frames 
using the Repeat option.

Fig. 8.14 Current Project
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Now, complete the second scene as per the storyboard.

	� Include the background image in the first column and the 
image of water in the second column.

	� Include the image of background and water into all the frames 
using (Repeat).

	� Include the image sequence to the first frame in the third 
column.

 Image sequence is to be added in the same way as image is 
added.  But here, as many frames as the number of images in 
the sequence will be formed instead of one frame.

While Preparing Image Sequences
The file names of the images should be given as in a pattern while preparing image 
sequences to include in OpenToonz.  Let's check the image sequence provided in the 
Sequence folder. When including such image sequences in the scene, only the common 
name in the image file name will be displayed in the Browser Room of OpenToonz.

For example, when including an image sequence with names luna _01.png, luna_02.png, 
luna_03.png, ......... only its common name,  luna_.png will be displayed in the Load level 
window. The number of image frames included in the image sequence can be seen in the 
Frames section.

So, image sequence has been added to the first frame of the 
third column.

The scene in the sequence shows stagnant water being carried 
by Luna through the channel towards the plant.  This scene will 
be complete only if this sequence is included in the remaining 
frames as well.

Fig. 8.15 Load Level Window
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Use the note below to include the sequence of images in all 
frames.

	 	To Insert the Image Sequence into Frames
	� Click on the frame containing the first image in the sequence.

	� Press and hold the Shift button and click on the frame containing the last image in the 
sequence

	� Then, use Click and drag to repeat selected cells to insert the image into the entire frame

	� Play the animation using the Play Button.

Have you tried running the animation with the image sequence 
included?

Is the animation of Luna directing the stagnant water, in the 
correct form now? 

Use the Animate tool to adjust the size and position of the 
image of water in the second column and the position and size 
of Luna in the image sequence and then play the animation.

You can make the scene more attractive by adding background 
sound to the scene and an animation of a cloud moving in 
another column.

Once all the activities are completed, don't forget to render and 
save the animation video in your folder.

Let's Combine Scenes
The next step is to combine the animation scenes we have  
prepared into a small animated movie. For this, you can use 
any video editing software available on Kite GNU Linux.

You may use the Kdenlive software, which you have learned 
in the previous class.  Don't forget to add title slides while 
preparing the movie.

If you need to make any changes to the prepared scenes, 
just open the previously saved project file (.tnz), make the 
necessary changes, and then render the video.

Animation Opportunities

Animation is widely used 
today in various fields such 
as film, advertising, industry, 
education, healthcare, 
gaming, etc. It is desirable 
for animation designers to 
have expertise in more than 
one field along with technical 
expertise. Animation is also a 
great career field today.
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Let us Assess

 	The names of some rooms (workspaces) in OpenToonz software are given.  Note down their 
uses.

	 Given below are the icons of some important tools in OpenToonz.  Complete the table with 
their uses.

Extended Activity

1.	 Create the third scene of the animated film Luna using OpenToonz. Combine this with 
the first and second scenes you created earlier and make a complete film. (Resources for 
creating the animation are in the folder Animation/Scene_3).

2.	 Create an animated film to be shown on World Anti-Drug Day based on the slogan "Say No 
to Drugs". Create the necessary images in Inkscape or GIMP.

Name of the Room Use
Animation

Drawing

Browser

Tool Use


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Chapter 9
To the Information Storehouse 

You might see various kinds of information about the 
match, the players, and the venue being displayed on 
television during the live telecast of sports events. 
Have you ever wondered how such interesting and contextual 
information becomes instantly available during the game?

All this information related to the matches is made available to 
us with the help of a pre-collected and stored database system.

Knowingly or unknowingly, database has a major influence on 
our lives.  A few examples are given below. Complete the ones 
that are incomplete:.

	� Election results and related details displayed on television.  

	� Exam results and their analysis made available on websites. 

	� ...............................................................................................

	� ...............................................................................................

	� ...............................................................................................
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You have learned in the previous class that spreadsheet software 
can be used to store and analyze information in tables.

Let's Find the Information in the List
Look at Figure 9.1. The table has been prepared in LibreOffice 
Calc with some information related to the Cricket World Cup.

Fig. 9.1 Table Prepared in LibreOffice Calc

Can you find the answers to the following questions from this 
table?

	� Which country won the Cricket World Cup in 2003?

 The best player in the tournament

 His country

	� How many times has the player from the country that won the 
Cricket World Cup been the best player in that tournament?

All this information can be made available very quickly on 
examining the data in the table given above. Here, we need 
to examine only  a few data. But if we examine the data of all 
the cricket matches played since the first official cricket test 
between England and Australia in 1877, is it easy to examine 
and find the information of thousands of matches and as many 
players from one table?

What information will 
be there in the football 

World Cup table?
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Try to find out the answer of the following question too from 
the figure 9.1

	� Which New Zealanders have been the tournament's best 
players?

Martin Crowe, Kane Williamson etc., right?

Information from Different Lists
Look at the information in the spreadsheet mentioned 
above, recorded in another form as tables.

Country_ID Country_Name

C100 Pakistan

C101 Sri Lanka

C102 India

C103 Australia

C104 New Zealand

C105 South Africa

C106 England

Table 9.1 Details of the country

Player_ID Player_Name Total_Runs Country_ID

P5001 Sanath Jayasurya 221 C101

P5002 Sachin Tendulkar 673 C102

P5003 Lance Clusener 281 C105

P5004 Martin Crowe 456 C104

P5005 Glenn McGrath 67 C103

P5006 Yuvaraj Singh 362 C102

P5007 Mitchel Starc 73 C103

P5008 Kane Williamson 578 C104

P5009 Virat Kohli 765 C102

Table 9.1 Details of the players

Year Winner Best Player

1992 C100 P5004

1996 C101 P5001

1999 C103 P5003

2003 C103 P5002

2007 C103 P5005

2011 C102 P5006

2015 C103 P5007

2019 C106 P5008

2023 C103 P5009

Table 9.1 Details of the Matches

Matches Table

Country Table

Player Table
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Have you examined all the tables?

Are the answers to the questions we discussed earlier available 
from these tables?
For that, we will have to relate the three tables and examine 
them, right?
From these new tables, is it possible to find out from which 
country is the best player of 2011 World Cup?
How could you arrive at this answer?

	� In the new tables, a special indicator (ID) has been given to 
the country, players, winner, and best player.  Based on this,

	� We can find the ID of the best player in the 2011  World 
Cup from the Matches Table.  This ID is P5006.

	� We can understand from the Player Table that the	
ID P5006 belongs to the player Yuvraj Singh.

	� We can find out from the Player Table itself that Yuvraj 
Singh's Country_ID is C102.

	� It is given in the Country Table that C102 is the 		
Country_ID of India. 

That is, the best player in the 2011 World Cup is an Indian.

Thus, all the information in the Calc sheet shown at the 
beginning of the lesson can be found by relating these three 
tables.

Is there any advantage in organizing the information in 
different tables like this?

	� The same information is not recorded repeatedly in these 
tables.

	� All the information related to a subject is put in one table 
here. You can understand their contents from the names of 
these tables. For example,  Country, Player, etc.

To the Database Management System
Finding information from multiple tables by relating them is 
not as easy as finding information from one table.

But what if we had computer software that could help us find 
and provide the information we need from such interconnected 

Is it dificult to 
collect information 
from more than one 

source?
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tables? Such software is called Database Management Systems 
(DBMS). 

DBMSs not only provide us with the recorded information in the 
way we need, but also help us store it, make changes to it, and 
eliminate unnecessary ones. It is with the help of such software 
that we can display and analyze large amounts of collected 
information very quickly today.

DBMS Software

The information stored in DBMSs is presented to the user 
in an easy and attractive manner with the help of techniques 
like html,, Java, Python, etc. Important DBMS softwares are 
Oracle, MySQL, SQL Server, and sqlite.

DATABASE	

We have examined the information from the tables related 
to the Cricket World Cup here. A database is a collection of 
tables in which such interrelated information are recorded in a 
systematic manner.

We can prepare a database by including  information in this 
table in a DBMS software.

Suppose that we used a database named cricket_worldcup 
and its tables Country and Player to find the answers to the 
questions. We shall now prepare a database of this type and its 
tables.

COUNTRY PLAYER MATCHES

Country_ID

Country_Name

Year

Winner

Best_Player

Player_ID

Player_Name

Total_Runs

Country_ID

Fig. 9.2 Tables of the Cricket_worldcup Database

Cricket_worldcup
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See the tables 9.1 to 9.3.  There are many rows and columns 
in each one of these tables.  What are the columns in the table 
Player ?

	� Player_ID

	� Player_Name

	� Total_Runs

	� Country_ID

These are called Fields of the table in relation to Databases 
(Fig 9.3)

Fields

Fig. 9.3 Fields of the Table

Similarly, note down the fields of the other tables (9.1, 9.3)

	� Country : .....................................................

	� Matches : ....................................................

The information collected in each field of the table is different. 
The names of the players contain letters whereas the field of 
Total_Runs will be numbers, right? That is, the information 
collected in each field will be composed of different Datatypes.

Observe the table given below.

    Sl. No.          Fields       Datatype

1 ID of the country Text

2 Year of game Number

3 Date of game Date

4 Picture of the player Image

Table 9.4 Some Datatypes

Which tables 
will be needed 
to analyse the 
test results?
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You have seen some common datatypes. Apart from these, Audio 
and Video are also datatypes. But they are known by different 
names in each DBMS.

Details about the player is given in rows. These rows in the table 
are referred to as Records (Figure 9.4).  All the information 
collected about a player can be found in a record in the Player 
table.

Records

Fig. 9.4 Records in the Table

In the Case of the Same Data
Look at Figure 9.3. Why is the field Player_ID included in this 
table?
Suppose there are more than one children with the same name 
in your class. Do you know what is used to identify such 
children with same name in the records related to the class?

	� Their Roll No will be different, right?

Similarly, accurate data can be obtained only if we are able to 
distinguish each record in a table from the other records.

Thus, the fields added to identify each record in each table 
from others are called Primary key (Figure 9.5).

Some other such cases where one record is added to distinguish 
one from another while storing information are given below. 
Try to add similar ones.

Fig. 9.5 Primary Key in the Table

Primary Key
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	� Admission Number is given to students.

	� Book code is given to books in the school library.

	� School Code is given to all schools.

	� ...............................................................................................

	� ...............................................................................................

	� ...............................................................................................

Let's Create a Database for the Cricket World 
Cup
We have already learned some things about database management 
systems. Let's see how to create a database containing information 
related to Cricket_worldcup matches using these. We shall do 
this using SQLite, a DBMS that belongs to the free software 
category.

Open the software DB Browser for SQLite on your computer 
and create a database with Cricket_worldcup as file name and 
save it in your folder.

To Prepare Database Using Sqlite

	� Open DB Browser for SQLite 
on your computer.

	� Click on New Database to  
create a new database (fig 9.6)

	� Give the name of the Database 
(Cricket_worldcup) against 
Name in the window that 
opens.

	� Then, select the folder to 
which you want to save and 
click Save.

Fig. 9.6 DB Browser for SQLite Window

Thus, the window for creating table will be displayed.  le 
creation window.  We have to create our tables here.
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Shall we prepare the table Country first?

To Prepare Table in DB Browser for SQLite

	� Give the name of the table (Country) against Table in the 
Edit table definition window.

	� Then, click on the Add button below.

	� Edit the name of the field as Field1 against Name.

	� Add other fields in the same way.

  Fig. 9.7 DB Browser for SQLite-Edit Table Definition Window

In the table Country, we need to add two fields - Country_ID 
and Country_Name. Once Country_ID is added, we can select 
its datatype.

Country_ID consists of letters and numbers, such as C100.   
So, guess what will be its datatype.

In our record, Country_ID is the field with a unique value used 
to identify it. Therefore, we can set Country_ID as the Primary 
Key.

Sqlite

Sqlite is a DBMS that is 
completely a free software.  
This system can be used in 
desktop software, mobile 
apps, and web applications.  
In Sqlite, the database is 
stored as a single file on 
disk. Therefore, the database 
can be easily managed and 
configured.

Sqlite was developed by 
D.Richard Hipp, a software 
engineer.
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To Set Primary Key in DB Browser for SQLite

	�  Click on the field which has to be set as the Primary Key

	�   Then, enable tick mark in PK.

      Fig. 9.8 How to set Primary Key in DB Browser for Sqite

	�  Click OK after including necessary fields.

Primary Key

Now, include the field Country_Name in the same way (Fig 
9.9).

With this, you can see the table named Country under the 
Tables section of the main window (Figure 9.10).  

Fig. 9.9 Fields Included in Table

What will be the primary 
key of the table - captains 

in the School Sports 
festival?
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Fig. 9.10 DB Browser for SQLite – Database Structure window

Let’s Add Information into Database
We have already created the required tables in the database 
related to the Cricket World Cup. Now we need to add 
information to these tables.

For this, Insert new record to current table option is available 
in the DB Browser for SQLite window.

To Add Records in DB Browser for SQLite

	� Select the tab Browse Data in 
window.

	� Select the table to which records 
are to be included.  (Here we have 
created only Table, Country and so 
it will be selected)

	� Then, click on the button Insert new 
record to current table.

	� Now, add the records one by one by 
typing.

Fig 9.11 DB Browser for SQLite – Method to Add Records

The Selected 
Table

In the table, Country that you have created, add the details 
from Table 9.1, one by one using the Insert new record to 
current table feature (Figure 9.12).

To include 
Records To save 

changes
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Fig. 9.12  Details Included in the Table Country

Similarly, prepare the tables – Player, Matches and include the 
details given in table 9.2 and 9.3 accordingly.

Fig. 9.13  Records Included in the Table Player

Discuss why INTEGER datatype has been given to the Total_
Runs field of the table Player.

Let's Retrieve Information from the Database
We have created the tables required for the Cricket_Worldcup 
database and added various records to them.  To view all the 
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records added to these tables, just click the Browse Data tab 
and select the table.

But how do we find only the information we need from this?

For example, suppose we want to find the number of runs 
Sachin Tendulkar has scored from this database.

There are only very few information about the players in 
Player table of the database we have created.  So, we can open 
the table through the Browse Data tab and quickly find it.  But 
if there are thousands of players in this table, is this task easy?

The way to do this is by using SQL Queries.

Notice the equivalent SQL queries are displayed when the 
table is created in the DB Browser (Figure 9.13).

So, to find the number of runs scored by Sachin Tendulkar 
from the Player table, simply enter the following query in the 
Execute SQL tab and run it (Figure 9.14).

‘select Total_Runs from Player where Player_Name='Sachin 
Tendulkar'Structured Query 

Language (SQL)

DBMSs communicate 
using a special computer 
language called Structured 
Query Language (SQL). It 
is a language that can be 
used very easily, like the 
English language. Not only 
can you select information 
from tables, but you can also 
create and modify tables, 
insert information into tables, 
edit and delete information.

In some DBMSs, these 
operations can only be 
performed using SQL.

Click here to run the 
query

Fig. 9.14  Execute SQL Window

Output
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Now, write and run an SQL query to display the name of the 
player who scored 765 runs in the Player table.

	� select Player_Name from Player where Total_Runs=765

More SQL Queries
Some SQL statements to retrieve information from the Player 
table are given below.  Run them and complete the table.

SQL Statement Use

1
select Player_Name from Player where Total_
Runs>300

to get the names of all the players who 
have scored more than 300 runs

2
select Player_Name from Player where Total_
Runs between 200 and 400

3
select Player_ID, Player_Name from Player 
where Country_ID='C103'

4 select * from Player to get all the details from the Player table

5
select Player_ID, Player_Name from Player 
where Country_ID in ('C103', ‘C105’)

6
To get the names of the players who have 
scored less than 400 runs.

Table 9.5 Some SQL Statements and their Uses

Retrieving Data from Multiple Tables
We have now seen a few SQL queries that retrieve data from 
the Player table. 

Now consider the query given below.

	� Which country is the player ‘Sanath Jayasuriya’ from?

The Player table does not provide the country of each player. 
Instead, Country_ID is provided.  To find the country with the 
given ID, we will have to examine multiple tables (including 
the Country_ID field in the Country table).  
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Foreign key

Fig. 9.15 When more than one Tables are Examined for Information

That is, here the field Country_ID in the Player table is used to 
find the relation with the Country table. Such fields are known 
as Foreign keys (Figure 9.15).

Here, note that a foreign 
key refers to the primary key 
of the table with which the 
relationship is established.

If so, what will be the SQL query to find out the nationality of 
‘Sanath Jayasurya’ ?

We have discussed that this information will not be available 
from a single table.  So,

	� We get the Country_ID of Sanath Jayasurya as C101 if 
we give 0Select Country_ID from Player where Player_
Name=’Sanath Jayasurya’ as query.

	� We can know that the country with C101 as ID is Sri 
Lanka from the Country table.  But if there are hundreds of 
countries in this table, this is not easy. 

If so,  what will be the query to find out the name of the country 
with C101 as ID from the Country table?

	� select Country_Name from Country where Country_
ID=’C101’

Now, combine this statement with the former one -

	� select Country_Name from Country where Country_
ID=(Select Country_ID from Player where Player_
Name=‘Sanath Jayasurya’)

In the same way, try writing and running an SQL statement to 
find out which country the player Lance Clusener belongs to.
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Let’s Asses

 	Which one is used to distinguish the records of a table from the others?

	 a) primary key  	 b) foreign key  	 c) fields  	 d) private key

	 SQL means  ................?
	 a) Systematic Query Language		  b) Structured Query Language
	 c) Structured Questions Language		 d) Sequenced Query Language

Extended Activities

App_ID App_Name App_Category
Usage_Duration 

(Minutes)
100 Samagra AI Education 60
101 Facebook Social Media 32
102 Youtube Social Media 15
103 E-cube English Education 25
104 G-Combris Education 20
105 Whatsapp Messaging 35
106 G-pay Banking 10
107 Maps Navigation 5

1.	We have understood the need to control internet usage and screen time. Below is a table 
containing the data collected from a survey conducted among students regarding screen time. 

Create a database called Screen_Usage and prepare the tables as shown below.

Now, try writing and executing the following SQL statements from the Apps table.

	� Which all Educational Apps are made available?

	� Which all Apps are being used more than 30 minutes in a day?

	� To which category does the SAMAGRA AI App belong?


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Chapter 10

Software and Freedom 

Until the 1980s, the development of computers and software was marked by collaboration 
and shared contributions. During this period of rapid technological growth, commercial 
interests were relatively minimal. However, in 1979, a popular word processing software 
called Scribe introduced a hidden, secret code in its program, marking the beginning of a 
new era. This software was designed with a "time bomb"—a piece of code that would render 
the program inoperable exactly 90 days after being copied and run on a system. The only 
way to reactivate it was for the user to pay the manufacturing company. 

Richard Stallman

This incident caused a major uproar in the software development 
world at the time. Renowned computer programmer Richard Stallman 
famously criticized this practice, stating:

"This is the murder of programmers' ideals. Instead of upholding the 
principles of sharing and collaboration, we are now forced to bow 
to corporate demands—creating a system where knowledge must be 
paid for."

But times have changed. Business has become heavily monopolized, with profit-driven 
motives now dominating the field. Nevertheless, glimmers of hope remain—let us examine 
how.
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Software and its 
Program
To create software, there are 
many programming languages 
like Python, C, Java, Rust, and 
more. We have already learned 
how to write small programs 
in Python.

The human - readable 
instructions (written in a 
programming language) that 
make up a program are called 
source code (see Figure 10.1). 
This source code can be edited 
based on the syntax rules of the 
programming language.

Before a computer can run a 
program, the source code is 
converted into a format that 
the machine can process. This 
converted form is called object 
code (or executable code). 
Unlike source code, object code 
cannot be easily modified.

Fig. 10.1 Source Code of a Python Program

Python and Source Code
The creators of the Python programming language included 
a key principle in its foundational guidelines (The Zen 
of Python): "Code should be written in a readable and 
clear manner." This is why Python programs are typically 
distributed as source code itself. When the program is 
executed using an interpreter, the source code is converted 
into object code on the fly.

Since programs distributed as source code it allows users to 
read, learn, and modify them, the software's license terms 
must explicitly specify the conditions under which changes 
to the source code are permitted.
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However, there is another side to this. Suppose the source codes 
of software are made available for others to examine and study. 
What are the outcomes?

	� Users can examine how the software works, allowing them 
to trust and confidently use the programs they rely on.

	� Those who are interested can learn the program. Those who 
are skilled can make changes and improve it if necessary. 
Improved or unimproved versions can be distributed. This 
will allow knowledge to reach more people.

	� Collaborative development leads to higher-quality software. 
The likelihood of bugs and vulnerabilities is reduced. This 
reduces the risk of computer viruses and malware.

	� Software companies move away from sales monopolies and 
instead focus on efficiency and quality service.

	� Since the software is not proprietary, companies using it 
can produce tools at lower costs, making technology more 
affordable.

	� ...............................................................................................

Let's Check the Source Code
Keeping the above points in mind, let’s analyze the source 
code of a small program:

The software Calculator.pyc  written in Python, is given in 
the School Resources/Class_10 folder on your computer. Try 
running this file using python 3.

Observe the current button colours in the software (Figure 
10.2). What if you want to change these colours to your 
preferred shades? 

To Run the File Using Python3

	� Open the terminal by right-clicking on the folder where the Python file is saved and 
selecting Open in Terminal.

	� Type the command below in the terminal and press Enter. 
python3 filename (Ex: python3 Calculator.pyc)
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Fig. :10.2 Calculator Software 
Prepared in Python

For this, we need to make the necessary changes to the 
Calculator software program and update it. Since the file 
Calculator.pyc is the object code of the software, we cannot 
edit it. So, if we want to change the program, we need its 
source code. This is provided in the Source folder as a Python 
file called calculator.py .

Open this file, find the code that gives the colour to the buttons, 
change it to a different colour, and try running it.

What if you want to change the calculator's name from Tom 
to yours?

Software Publishing
Creating software is just the first step—it must also be published 
effectively for others to use. When releasing software, keep 
these points in mind:
1.	 The software should be made publicly available in a way 

that allows easy download and use.
2.	 If users are permitted to read, modify, and redistribute the 

software, its source code must also be published. The terms 
for modification and redistribution should be clearly stated 
in an easy-to-understand manner.

3.	 Allow the software to be improved (upgraded) or forked 
(modified into new versions). Different versions should be 
organized sequentially for clarity.

4.	 Clearly define the license conditions for any modified 
versions of the software.

There are several services available that incorporate all the 
above possibilities and help publish software online. Below 
are some of them:
	� GitLab (https://about.gitlab.com)
	� GNU Savannah (https://savannah.gnu.org)
	� Gitea (https://about.gitea.com)
	� GitHub (https://github.com)
	� SourceForge (https://sourceforge.net)
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Table 10.1 License Usage Rights

Rights granted
Various licenses

GPL Apache EULA

0 for the user to  use for any purpose. provides provides No

1
 reading and learning source code provides provides No

copying and editing as needed provides provides No

2 To distribute copies of the software and to provide follow-
up services using them

provides provides No

3 To redistribute modified or unmodified versions
Provides on 
condition

provides No

A To obtain another license for the modified parts No provides No

B To distribute together with other software with different 
licenses (Software package)

No provides No

Beyond the previously mentioned licenses, there exist other 
licenses that either grant additional rights or impose further 
restrictions. See the following examples.

When publishing the developed software, the terms and conditions 
we specify must be formalized into a legally valid one.  Since it 
is difficult to legally register the terms when we prepare them 
ourselves, we can  opt for pre-existing standardized licenses 
prepared by established organizations. 

A software license defines the rights granted to users regarding 
how the software may be used. Below are some software 
licenses:

	� GNU Public Licence
	� BSD (Berkeley Software Distribution) licence
	� End-User Licence Agreement (EULA)

These all provide different usage rights to the user. See Table 
10.1 below.



Software and Freedom

Information and Communications Technology-10 75

It appears that a 
separate license is 

needed for each computer 
when we use proprietory 

O.S.

	� The source code  can be distributed with or without 
modifications. However, you must ensure that the original 
license applies to any modifications or additions. Such 
software can be called free software. These can only be 
used by combining them with other free software, such 
as the GPL (General Public License) published by GNU. 
GIMP is software distributed under this license.

	� Software can be modified and redistributed, and the 
programmer can decide the terms of distribution of (only) 
the combined parts. There is no problem distributing it as 
a single package with other non-free software. These are 
generally called open source licenses. There are several open 
source licenses that vary in detail. The Apache License, 
which distributes the Android operating system, is an open 
source license. The Berkeley Software Distribution (BSD) 
License is an example.

	� As mentioned, there are software that only provides object 
code. Some of them can be installed on any system. Some 
can be used indefinitely. Some software is also distributed 
for free. These fall into the category of freeware

	� Some of the above types can only be used for a limited 
time (Testware). These do not grant any other rights.  

	� Software that provides only object code will have usage 
restrictions, allowing it to run only on a registered, specific 
system. Even if you have another computer, a new license 
must be obtained for it. Operating systems like Microsoft 
Windows and Apple iOS fall under this category.

In essence, free software prioritizes principles such as user 
freedom, the dissemination of knowledge, ethics, justice, 
and public good. Most free software is developed through 
voluntary efforts and is available free of charge.

Open-source software, on the other hand, emphasizes 
universal accessibility, collaboration, usability, improvement, 
and innovation. A middle-ground approach has emerged in 
the form of FLOSS (Free/Libre and Open Source Software) 
licenses.
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(The English word 'Free' in this context refers to 'freedom' 
rather than just 'zero cost.' Such licenses emphasize that the 
software must be free—as in liberty—not necessarily free of 
charge.)

Versions and Forks
Any software in use undergoes periodic updates over time. The purpose of creating a new 
version is to rewrite the security code of the program, improve existing features, add new 
functionalities, etc. Software versions are typically indicated by a numbering system. For 
example, Kazium Version 21.12.3 means the 21st major version of the Kazium software, the 
12th interim improvement, and the third minor changes (patches).
Fork is applicable only in open/free software. Those who disagree with the views, methods, 
or features of existing software - rewrite and distribute the software source code as permitted 
by the software's license. For example, the two forks we use, LibreOffice (published by The 
Document Foundation) and Apache OpenOffice (published by the Apache Software Foundation), 
are two forks of the defunct OpenOffice software.

Let's Check the Licenses
As mentioned earlier, the GNU General Public License (GPL) 
falls under the first category of free software licenses. The key 
terms of this license (listed as items 0, 1, 2, and 3 in Table 
10.1) should be noted separately in your notebook. These 
terms define the essential conditions for free software.

Why is the First Term Numbered '0'?

Check Software Licenses on your Computer  as given below. 

To Check Licenses
To check the license of the Krita software on our operating 
system,

	� Open the software window and check the Help menu in 
the menu bar.

	� When you click About Krita, check the License item in 
the window that appears.

	� It should be noted that Krita is distributed under the GPL 
license.
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Mozilla Firefox, the web browser we use on our computers, is 
licensed under the Mozilla Public License. This is a FLOSS 
license. See Figure 10.3 below.

Fig. 10.3 License of Mozilla Firefox

Complete Table 10.2 by identifying the licenses for the software 
we use for various purposes. Check on the internet if needed.

Software License Category Special Terms

LibreOffice
Mozilla 
Public 

Licence
FLOSS

Trademarks used in the software may not be freely 
used.

Scratch

Firefox

Chromium

GeoGebra

Table 10.2 Details of Software Licenses

History of Licenses
As we know, progress in the world has always been built upon 
prior knowledge and discoveries. By the 1980s, a debate emerged 
that software source code—like literary works such as stories and 
poems—should be recognized as original intellectual creations. 
This idea gained legal acceptance first in the United States and 
later in other countries, bringing program source code under 
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Unix Operating System
Developed during 1969–70 under the leadership of Ken Thompson, Dennis Ritchie, and Douglas 
McIlroy at AT&T (one of the world’s largest telecom and software companies at the time), 
Unix became a foundational operating system. Its development began in 1969, and later, its 
ownership rights were transferred to various other companies. These versions, after significant 
changes and additions, have been used in the operating systems of Apple Corporation (Mac OS 
X) and the University of California, Berkeley (BSD - Berkeley Software Distribution). Many 
of today's operating systems are developed from Unix or have been rebuilt based on Unix.

The GNU Project and Its Software

The GNU Project, founded by Richard Stallman, attracted 
programmers from around the world who contributed without 
profit motives, creating nearly all essential free software 
components.

copyright law. As a result, reusing a program’s code or parts 
without permission became legally equivalent to plagiarism or 
literary theft.

A programmer's work must be protected from being stolen by 
others. This is society's responsibility towards that individual. 
However, this led to the hiding of program codes and attempts 
to establish monopolies in software. To address this, software 
licenses came into use, some of which strongly oppose the free 
dissemination of knowledge..

Free Software Foundation
Along with the aforementioned commercialization, there were 
indeed strong counter-movements. One such pioneering initiative 
was the GNU Project, established in 1983 by renowned computer 
programmer Richard Stallman. The primary objective of this 
project was to create and make freely available software that 
could be used with complete freedom. To support these efforts, 
the Free Software Foundation (FSF) was formed to create and 
improve software for the GNU Project, a non-profit organization 
of volunteer programmers that began in 1985. Today, the 
organization has branches and many activists around the world.
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	 	GNU (GNU is not Unix)

When Richard Stallman called on the programming 
community around the world to create a new operating 
system, hundreds of programmers came forward to 
collaborate with the GNU Project. Most of them worked 
for various other organizations. But Stallman was unable 
to bring them together or explain the project at the time.  

Copy Left

If a software developer wishes to grant users the freedom to 
use, copy, modify, and redistribute a program, these rights must 
be legally guaranteed. Copyleft is a licensing method that uses 
copyright law itself to ensure that all users retain these freedoms.

With these constraints, the practical approach was to create 
a new system modeled after an existing one. Therefore, 
Stallman asked for the Unix operating system to be used as 
a model in this regard. Everything that was in Unix should 
be included in the new operating system. But it was imperative that none of the Unix program 
codes be used. Then, the programmers who collaborated on the project rewrote Unix, without 
copying the codes. This is what the name GNU (GNU is not Unix) refers to.

Copyleft does not mean that the software is unregistered or 
unprotected by copyright law. Rather, it means that the rights 
have been formally registered and granted to the user under 
specific terms that ensure freedom.
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The GNU Project and Linux

An operating system has two main parts at the functional level. One part is called the Kernel 
and the other part is called the Shell. The kernel is the part that directly interacts with the 
computer's hardware. The shell is the part that interacts with the user. The graphical user 
interface (GUI) part of the operating system, which consists of software windows, is associated 
with the shell (Figure 10.4).

Fig.:10.4 Operating system – working phase

to build was called The Hurd. However, even after 
all the other software of GNU was completed, the 
Hurd was not completed. Around the same time, 
a Finnish programmer named Linus Torvalds 
completed and published a kernel program called 
Linux. Torvalds, who had listened to Stallman's 
requests for GNU, built the new kernel in such a 
way that it could run the software that the GNU 
Project was developing. The combination of these 
two was the GNU/Linux operating system that we 
use today.
The kernel and other parts of the GNU/Linux 
operating system we currently use are given below.

The term "Shell" originates from the Unix operating system. When examining how GNU 
developed its version, the name "Bash (GNU Bourne Again Shell)" is highly meaningful.

Kernel Linux
Shell GNU Bash (GNU Bourne Again Shell)

Free Software Development
You may have heard of the Microsoft Windows operating 
system. Microsoft, a proprietary software company, employs 
its own programmers to develop and improve Windows.

However, free and open-source software (FOSS) is not 
developed this way. Instead, it follows a different approach, as 
described below.
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	� Publishing the concept, methods, and features of a software 
on the Internet.

	� A prototype of it is being published.

	� Any user from any corner of the world can participate in the 
subsequent activities. They can discuss ideas,  add program 
codes and can correct mistakes.

What Infrastructure is Needed for This Approach?

	� Many contributors will create multiple versions of the 
software. These versions must be properly stored and 
managed.

	� Each version should indicate which parts of the source code 
have been modified and which changes have been proposed.

	� If major changes cause issues, developers should be able to 
roll back to a previous version. Hence, every version must 
be preserved.

	� ...............................................................................................

Git is an online software that handles all of the above needs. 
It is a system created by Linus Torvalds, the creator of the 
Linux kernel (Figure 10.5), for the collaborative improvement 
of his software. Apache Subversion, developed by the 
Apache Software Foundation, is a software for centralized 
improvement.

GitHub, GitLab, GNU Savannah are popular platforms that 
rely on such version control software for publishing and 
managing code.

GNU-Linux Distributions
We have discussed that GNU-Linux is licensed in a way that 
allows anyone to copy, modify, and redistribute it. Taking 
advantage of this opportunity many  versions of GNU-Linux 
programs  have been created. These distributions vary widely 
based on the developers' vision and the specific needs they aim 
to fulfill.

Fig. 10.5 Linus Torvalds

Cathedral Model and 
Bazaar Model

Have you noticed the ways  
Microsoft and Linux build 
software?

Eric Raymond, a famous 
writer on technology, called 
this the Cathedral Model and 
the Bazaar Model.
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Android
Android is a widely used operating system in touchscreen 
mobile phones, tablets, and other devices. It is based on the 
Linux kernel, and its program code is available under an open-
source license.

Android is a prime example of how free and open-source software 
(FOSS) benefits society. By using Android, manufacturers can 
produce smart devices like mobile phones and sell them at lower 
prices, as they don’t have to invest heavily in developing their 
own operating systems.

Open Hardware
It's not just software that is being monopolized. The technology 
behind computers, other electronic devices, and mechanical 
components is also being monopolized in this way.

These are the following stages in the manufacturing of an 
electronic device.

	� Outline of the general organization of machine , illustrations, 
diagrams, etc. that help in the construction of components

	� Required component structures and their manufacturing 
methods

	� Layout diagrams of electronic chips

	� Special software (drivers) for the operation of components

	� ...............................................................................................

If the above-mentioned [technologies/components] are 
obtained, any company with the technical capabilities to 
manufacture electronic devices can produce them.

Conventionally, large corporations invest significant capital in 
research and development to create specialized equipment, but 
they rarely publish their manufacturing methods.

However, just as we saw earlier with free and open-source 
software, there is now a growing open-design movement for 
hardware components released under free manufacturing licenses.

An example of this is the Arduino microcontrollers (Figure 10.6), 
which are widely used in schools and follow open-hardware 
principles.

Some GNU-Linux 
Distributions

	� Debian GNU/Linux (from 
which there are many 
versions, such as  Ubuntu 
and the Kite GNU-Linux 
we use).

	� Red Hat Linux

	� Slackware Linux

(There are many other 
versions of each of these.)
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Fig. 10.6 Arduino Uno board

Let's Evaluate

 	 Which of the following is not an open source software license?

	 a) Apache Software License	

	 b) End User License Agreement 		

	 c) GNU General Public License  	

	 Which of the following is free hardware?

	 a) Apple mobile phones 	

	 b) Arduino similar chipset 		

	 c) Mobile phones with Android installed  

	 What is the name given to free software?

	 a) Free software	

	 b) Open software 		

	 c) Freeware

	 What is the shell in the GNU/Linux operating system known as?

	 a) Open Shell	

	 b) Linux Shell		

	 c) Bash

	 Which of the following is not an operating system?

	 a) Android 	

	 b) Linux	

	 c) Unix
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Extended Activities

1.	 Complete the table below by searching familiar operating systems on the internet.



2.	 Search the internet for the names of operating systems used in wearable devices such as 
smartwatches and VR headsets, and make a list.

Operating system Based program The device used

Ubuntu Linux Computer

iOS Unix

Android Linux mobile phone,.....
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CONSTITUTION OF INDIA

Part IV A
FUNDAMENTAL DUTIES OF CITIZENS

ARTICLE 51 A
Fundamental Duties - It shall be the duty of every citizen of India

a)	 to abide by the Constitution and respect its ideals and institutions,the 
National Flag and the National Anthem;

(b) 	to cherish and follow the noble ideals which inspired our national 
struggle for freedom;

(c) 	to uphold and protect the sovereignty, unity and integrity of India;

(d) 	to defend the country and render national service when called upon 
to do so;

(e) 	to promote harmony and the spirit of common brotherhood amongst 
all the people of India transcending religious, linguistic and regional 
or sectional diversities; to renounce practices derogatory to the 
dignity of women;

(f) 	to value and preserve the rich heritage of our composite culture;

(g) 	to protect and improve the natural environment including forests, 
lakes, rivers, wild life and to have compassion for living creatures;

(h) 	to develop the scientific temper, humanism and the spirit of inquiry 
and reform;

(i) 	 to safeguard public property and to abjure violence;

(j) 	 to strive towards excellence in all spheres of individual and 
collective activity so that the nation constantly rises to higher levels 
of endeavour and achievements;

(k) 	who is a parent or guardian to provide opportunities for education 
to his child or,  as the case may be, ward between age of six and 
fourteen years.



CHILDREN'S RIGHTS
Dear Children,

Wouldn’t you like to know about your rights? Awareness about your 
rights will inspire and motivate you to ensure your protection and 
participation, thereby making social justice a reality. You may know 
that a commission for child rights is functioning in our state called the 
Kerala State Commission for Protection of Child Rights.
Let’s see what your rights are:
• 	 Right to freedom of speech and 

expression.

• 	 Right to life and liberty.

• 	 Right to maximum survival and 
development.

• 	 Right to be respected and accepted 
regardless of caste, creed and 
colour.

• 	 Right to protection and care 
against physical, mental and 
sexual abuse.

• 	 Right to participation.

• 	 Protection from child labour and 
hazardous work.

• 	 Protection against child marriage.

• 	 Right to know one’s culture and 
live accordingly.

• 	 Protection against neglect.

• 	 Right to free and compulsory 
education.

• 	 Right to learn, rest and leisure.

• 	 Right to parental and societal 
care, and protection.

Major Responsibilities

	 Protect school and public 
facilities.

	 Observe punctuality in learning 
and activities of the school.

 	 Accept and respect school 
authorities, teachers, parents and 
fellow students.

 	 Readiness to accept and respect 
others regardless of caste, creed 
or colour.

Contact Address
Kerala State Commission for Protection of Child Rights

'Sree Ganesh', T.C.14/2036, Vanross Junction
Kerala University P.O., Thiruvananthapuram-34, Phone : 0471 - 2326603

 E-mail : childrights.cpcr@kerala.gov.in, rte.cpcr@kerala.gov.in  
 Website : www.kescpcr.kerala.gov.in

Child Helpline - 1098, Crime Stopper - 1090, Nirbhaya - 1800 425 1400
Kerala Police Helpline - 0471 – 3243000/44000/45000

online R.T.E Monitoring : www.nireekshana.org.in


